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HealthFile™ Quick Start Documentation 
 
 
Introduction: 
 
HealthFile™ allows for comprehensive tracking of personal health information and history for personal 
use or physician use. The software works on any Palm OS® handheld, Pocket PC or Windows Mobile 
handheld, and Windows PC. The Plus version includes PC desktop companion software with 
additional features. The Lite version runs only on Palm OS® handheld computers, and is intended 
primarily for Mac users. This document provides information on the handheld software, as the PC 
software has its own complete help file system. The handheld screenshots are taken from a Palm 
OS® handheld, but they look almost identical on the Pocket PC. 
 

Installation: 
 
To install the Plus version on a PC, download the setup file.  If this file is in ZIP format, you will need 
to first unzip the file with an unzip utility. Then, double click the .exe setup file to start the PC installer. 
The installer will install both PC and handheld software components. Palm OS® users will need to 
hotsync once the installer is finished to install the handheld files to your handheld. 
 
To install the Lite version, simply download the ZIP file to your PC.  Then, unzip the file with an unzip 
utility such as Winzip (www.winzip.com).  Once unzipped, install all *.prc and *.pdb files to your 
handheld using the Install Tool that was installed with your handheld desktop software. 
 

Registration: 
 
The software is initially installed as a trial version. After purchasing, a 5-digit registration code is 
provided. This 5-digit code is entered in the blank area on the startup screen on the handheld or on 
the PC software from the Help menu. Once the registration code is entered the handheld, tap 
Register. For Palm OS®, on the next hotsync, the registration code will be transferred to the PC. The 
Plus version, if installed, will detect this code and unlock the full PC version. The registration code 
unlocks the full version features. No additional installation is required. 
 

Getting Started: 
 
The following screens and descriptions explain many of the features in HealthFile™. The software 
was designed to be easy and intuitive, so it will be easy to get started. This documentation will help 
explain some of the advanced features. This document is intended to help users get started with both 
the Palm OS® and the Pocket PC versions of the software. 
 
To start the software on the handheld, tap the HealthFile™ icon. On Palm OS® handhelds, this icon 
may be in the Unfiled category. From the Home (icon) screen on your handheld, tap the drop down list 
in the upper right corner, then select Unfiled to list an uncategorized icons. A category can be 
assigned to the icon to make it easier to find. Consult your handheld manual for how to categorize 
icons. On Pocket PC handhelds, tap the Start menu icon in the upper left, then select Programs from 
the list displayed.  The HealthFile icon will be available from that screen of icons. 
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Main List Screen: 
 

 

Upon startup, the list of saved profiles is displayed. Simply tap any record 
in the list to view the profile 
 
Tap the New button at the bottom of the screen to create a new profile. A 
profile can be created for every member of a family, including each child. 
 
Also, the Find Area can be used to jump to a certain profile by entering 
the first few letters in the name. 
 
Tap the Prefs buttons to view the Preferences screen. 
 

 
Profile Topics Screen: 
 
 

 

The profile topics screen a list of buttons for each information topic. 
Simply tap a topic to view or enter information for that topic. 
 
To delete the current personal profile, tap the Delete button. 
 
To go back to the list of profiles, top the Back button. 

 
Topic Screens: 
  

 

 

There are many topic screens allowing for a great amount of information 
to be stored for each profile. 
 
Personal: store basic personal information including birthday, address, 
normal health values. 

 

Legal: store organ donor status, will information, and other legal type 
items. 
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Insurance: store information on all types of insurance; saves records to a 
master list for use in other profiles. 
 
Multiple entries can be saved per profile. A list screen is available for easy 
viewing and finding of a certain entry in the list. 

 

Contacts: store emergency contact information; saves records to a master 
list for use in other profiles. 
 
Multiple entries can be saved per profile. A list screen is available for easy 
viewing and finding of a certain entry in the list. 

 

Allergies: store information on any allergies for the personal profile. 
 
Multiple entries can be saved per profile. A list screen is available for easy 
viewing and finding of a certain entry in the list. 

 

Illnesses, etc: store information on previous illness, diseases, or 
conditions including symptoms, diagnosis, treatment, etc. 
 
Multiple entries can be saved per profile. A list screen is available for easy 
viewing and finding of a certain entry in the list. 

 

Surgeries, etc: store information on previous surgeries or hospitalizations 
including date, instructions, etc. 
 
Multiple entries can be saved per profile. A list screen is available for easy 
viewing and finding of a certain entry in the list. 
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Appointments: store information on any appointment, including date, time, 
reason, diagnosis, follow-up date, etc. 
 
Multiple entries can be saved per profile. A list screen is available for easy 
viewing and finding of a certain entry in the list. 

 

Medications: store information on medications or vitamins being taken, or 
previously taken, and prescription details. 
 
Multiple entries can be saved per profile. A list screen is available for easy 
viewing and finding of a certain entry in the list. 

 

 
Vaccinations: store information on shots and vaccinations, including date, 
physician, etc. In this example, the details screen is not shown. 
 
Multiple entries can be saved per profile. A list screen shown to the left is 
available for most topics.  This allows for easy viewing and finding of a 
certain entry in the list. 

 

Tests: store information on any kind of test or exam, including result, goal, 
physician, location, etc. 
 
Multiple entries can be saved per profile. A list screen is available for easy 
viewing and finding of a certain entry in the list. 

 

Blood Pressure: store blood pressure test results, including pulse, date, 
time, activity, etc. In this example, the details screen is not shown. 
 
Multiple entries can be saved per profile. A list screen shown to the left is 
available for most topics.  This allows for easy viewing and finding of a 
certain entry in the list. 
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Weight: store weight measurements, including date, time, and notes. 
 
Multiple entries can be saved per profile. A list screen is available for easy 
viewing and finding of a certain entry in the list. 

 

Glucose: store blood sugar test results, including carbs, insulin 
amount,date, time, event, etc. 
 
Multiple entries can be saved per profile. A list screen is available for easy 
viewing and finding of a certain entry in the list. 

 

Cholesterol: store total, LDL, HDL, triglycerides, date, time, note, etc. 
 
Multiple entries can be saved per profile. A list screen is available for easy 
viewing and finding of a certain entry in the list. 

 

Family History: store family history information to record illnesses and 
conditions of related family members. 
 
Multiple entries can be saved per profile. A list screen is available for easy 
viewing and finding of a certain entry in the list. 

 

Preferences Screen: 
 

 

The Preferences screen allows the user to customize several items. 
 
The currency symbol can be specific, as well as the date format and date 
separator (mm/dd/yyyy, etc.). The default glucose units can also be 
selected. Options can be turned on or off for backing up the Palm OS 
databases and confirming delete operations. 
 
Tapping the Set/Change Password button allows the password to be 
changed. 
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Setting or Changing the Password: 
 

 

For additional security, a password can be used.  To set or change the 
password, tap the Password button on the Preferences screen. 
 
Enter the old password if one exists, then enter the new password and 
retyped password.  The ‘abc’ button will bring up the on screen keyboard 
for easier text entry (Palm OS only).  The Bksp button will backspace one 
character. 
 
HealthFile data is not encrypted, but the password does prevent 
unauthorized users from viewing your information. 
 

 
Menu Options: 
 

A menu system is available to perform additional functions on the handheld. To view the menu system 
on Palm OS® handhelds, tap the Menu silkscreen icon (just below the Home silkscreen icon). Also, 
on many Palm OS® handhelds, the title bar for the application can be tapped while the application is 
running to display the menu system. On Pocket PC or Windows Mobile handhelds, the menu bar is at 
the bottom of the screen. 
 

File Menu:  
 
The File menu offers the following options: 
Export Date to Memo/Note – while viewing information details, select this 

option to export the information as text to a new memo (Palm OS®) or 
note (Pocket PC). 

 

 

Edit Menu:  
 
The Edit menu offers the following options: 
Edit Contact List – allows the user to edit the Master Contact List that 

can be used for any personal profile. 
Edit Insurance List – allows the user to edit the Master Insurance List 

that can be used for any personal profile. 
Edit Location List – allows the user to edit the Master Location List that 

can be used for specifying locations in different topics. 
Edit Pharmacy List – allows the user to edit the Master Pharmacy List 

that can be used for selecting pharmacies in Medications. 
Edit Provider List – allows the user to edit the Master Provider List of 

providers (physicians, etc.) that can be used to select a Provider in 
different topics. 

Edit Provider Type List – allows the user to edit the Master Provider 
Type List that can be used for specifying a provider type in the Master 
Provider List. 

Cut/Copy/Paste –standard functions. 
On Screen Keyboard – (Palm OS® only) - this menu option will display 

the on screen keyboard for entering text or numbers. This is useful for 
handhelds that do not have a virtual graffiti area. 
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Help Menu:  
 
The Help menu offers the following options: 
Help – selecting this option will display the help file available on the 

handheld. 
About – selecting this option will display the About screen, including the 

version number. 
Close – (Pocket PC or Windows Mobile) – fully closes the application on 

the handheld so that synchronization will work properly 

 

 

Desktop Software: 
 

The Plus version includes PC desktop software to manage information from the PC. Features 
available only on the desktop software include printing reports, graphing data, saving and printing 
graphs, exporting records, and other features. Date entry is also much easier on the PC companion 
software. Consult the help file on the PC desktop software for further information on the desktop 
features. Mac users may be able to run the PC desktop software under Virtual PC on the Mac. 
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Conclusion: 
 
If you are just evaluating or have already purchased HealthFile™ – Thanks! 
 
If you have questions about the software, or cannot find an answer to a problem at our site, please 
email our support staff. We will work hard to resolve your issue and answer your questions. 
 
 

 
 


